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1. การใช้งาน PDFSam 

1.1 PDFSam คืออะไร 

PDFSam เป็นโปรแกรมฟรีที่มีความสามารถในการรวมไฟล์ PDF (Merge), แยกบางหน้าที่ต้องการออกจาก
ไฟล์ PDF (Split) โดยโปรแกรมนี้เป็นโปรแกรมที่มีอยู่บน Windows และ Linux ซึ่งมีหน้าจอการใช้งานที่
ใช้ง่าย และยังเป็นซอฟต์แวร์แบบ Open Source (ไม่เสียค่าใช้จ่ายในการใช้งาน) 

1.2 การติดตั้งและการเรียกใช้โปรแกรม 

• ดาวน์โหลดติดตั้ง PDFSam จากลิงค์ http://www.pdfsam.org/download/ เลือก PDFsam 
Basic 

 

• เลือก Windows -> MSI Installer  

 

• ดับเบ้ิลคลิกไอคอน  

http://www.pdfsam.org/download/%20เลือก
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• ดับเบ้ิลคลิกไอคอน 
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• จะปรากฏหน้าต่างโปรแกรมดังรูป 

 
 

1.3 Function การทำงาน 

1.3.1 การรวมไฟล์ (Merge) 
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1.1) เลือกเมนู Merge 
1.2) รายละเอียดแต่ละปุ่ม 

- Add เลือกไฟล์ที่ต้องการรวม สามารถเลือกได้หลายไฟล์ 
- Clear ลบไฟล์ที่ต้องการรวมทั้งหมด 
- Remove ลบไฟล์ที่เลือก 
- Move up เลื่อนไฟล์ที่เลือกขึ้น 
- Move down เลื่อนไฟล์ที่เลือกลง 

1.3) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
1.4) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
 

1.3.2 การแยกไฟล์ (Extract) 

 
 

2.1) เลือกเมนู Extract 
2.2) รายละเอียดแต่ละปุ่ม 

- Add เลือกไฟล์ที่ต้องการแยก สามารถเลือกได้หลายไฟล์ 
- Clear ลบไฟล์ที่ต้องการรวมทั้งหมด 
- Remove ลบไฟล์ที่เลือก 

2.3) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
2.4) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
2.5) File names settings ชือ่ไฟล์นำหน้าชื่อไฟล์เดิม 
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1.3.3 การรวมไฟล์แบบผสม (Alternate Mix) 

 
3.1) เลือกเมนู Alternate Mix 
3.2) รายละเอียดแต่ละปุ่ม 

- Add เลือกไฟล์ที่ต้องการรวมแบบผสม สามารถเลือกได้หลายไฟล์ 
- Clear ลบไฟล์ที่ต้องการรวมทั้งหมด 
- Remove ลบไฟล์ที่เลือก 
- Move up เลื่อนไฟล์ที่เลือกขึ้น 
- Move down เลื่อนไฟล์ที่เลือกลง 

3.3) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
3.4) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
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1.3.4 การหมุนหน้ากระดาษในไฟล์ (Rotate) 

 
4.1) เลือกเมนู Rotate 
4.2) รายละเอียดแต่ละปุ่ม 

- Add เลือกไฟล์ที่ต้องการรวมแบบผสม สามารถเลือกได้หลายไฟล์ 
- Clear ลบไฟล์ที่ต้องการรวมทั้งหมด 
- Remove ลบไฟล์ที่เลือก 

4.3) เลือก Rotate Setting เพ่ือตั้งค่าหน้ากระดาษท่ีต้องการหมุน 
- Rotate (หมุนไฟล์) เลือก Even pages (หน้าคู่) หรือ Odd pages (หน้าคี่) 
- 90 degrees clockwise หมุนขวา 90 องศา 
- 180 degrees clockwise กลับหัว 
- 90 degrees counterclockwise หมุนซ้าย 90 องศา 

4.4) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
4.5) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
4.6) File names settings ชือ่ไฟล์นำหน้าชื่อไฟล์เดิม 
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1.3.5 การแยกไฟล์ PDF (Spilt) 

 
5.1) เลือกเมนู Split 
5.2) รายละเอียดแต่ละปุ่ม 

- Select PDF เลือกไฟล์ที่ต้องการแยกไฟล์ 
- Clear ลบไฟล์ที่ต้องการแยกไฟล์ 
- Remove ลบไฟล์ที่เลือก 

5.3) เลือก Spilt Setting เพ่ือตั้งค่าหน้ากระดาษที่ต้องการแยก 
- Split after (แยกไฟล์หลังจาก) เลือก Every page (ทุกหน้า), Even pages (หน้าคู่), 

Odd pages (หน้าคี่) 
- Split after the following page numbers แยกไฟล์หลังจากหน้าที่เลือก 
- Split by every “n” pages แยกไฟล์ทุก “n” หน้า ( “n” เช่น 1, 2, 3 เป็นต้น) 

5.4) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
5.5) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
5.6) File names settings ชือ่ไฟล์นำหน้าชื่อไฟล์เดิม 
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1.3.6 Spit by bookmarks 

 
6.1) เลือกเมนู Split by bookmarks 
6.2) รายละเอียดแต่ละปุ่ม 

- Select PDF เลือกไฟล์ที่ต้องการแยกไฟล์ (ต้องเป็นไฟล์ที่มีจุด bookmark) 
- Clear ลบไฟล์ที่ต้องการแยกไฟล์ 

6.3) เลือก Spilt Setting เพ่ือตั้งค่าหน้ากระดาษที่ต้องการแยก 
- Split after  

6.4) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
6.5) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
6.6) File names settings ชือ่ไฟล์นำหน้าชื่อไฟล์เดิม 
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1.3.7 Spit by size 

 
7.1) เลือกเมนู Split by size 
7.2) รายละเอียดแต่ละปุ่ม 

- Select PDF เลือกไฟล์ที่ต้องการแยกไฟล์  
- Clear ลบไฟล์ที่ต้องการแยกไฟล์ 

7.3) เลือก Spilt Setting เพ่ือตั้งค่าหน้ากระดาษที่ต้องการแยก 
- Split at this size กำหนดขนาดของไฟล์ที่ต้องการแยก   

7.4) คลิกปุ่ม Browse เพ่ือเลือกตำแหน่งที่เก็บไฟล์และระบุชื่อไฟล์ใหม่ที่ต้องการ 
7.5) คลิกปุ่ม Run เพ่ือประมวลผล ไฟล์จะถูกเก็บ ณ ตำแหน่งที่เราเลือกไว้ (ในข้อ 3) 
7.6) File names settings ชือ่ไฟล์นำหน้าชื่อไฟล์เดิม 
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2. การใช้งาน Foxit Reader 

2.1 Foxit Reader คืออะไร 

เป็นโปรแกรมเปิดไฟล์ PDF หรือแสดงไฟล์ .PDF เช่นเดียวกับ Adobe Reader แต่มีขนาดเล็กกว่ามากๆ 
ทำให้โหลดได้เร็ว และยังมีฟังก์ชัน ในการขีดเขียน หรือทำการโน้ตข้อความลงไปในตัวเอกสาร เพื่อทำการ
พิมพ์หรือจะเซฟบันทึกเอาไว้ และยังสามารถแปลงไฟล์ ทั้งหมดออกเป็นไฟล์ตัวอักษรได้  

2.2 การติดตั้งและการเรียกใช้โปรแกรม 

• ดาวน์โหลดติดตั้ง PDFSam จากลิงค์ https://www.foxitsoftware.com/downloads/ เลือก 
Foxit Reader 

 

• เลือก Windows -> English 

 

• ดับเบ้ิลคลิกไอคอน  

https://www.foxitsoftware.com/downloads/%20เลือก
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• ดับเบ้ิลคลิกไอคอน 

 

• จะปรากฏหน้าต่างโปรแกรมดังรูป 
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2.3 Function การทำงาน 

2.3.1 การดูข้อมูลในแฟ้ม PDF 

• เลือกคำสั่งบนแถบเครื่องมือ File -> Open หรือคลิกปุ่ม Open File บนแถบเครื่องมือ 
• เลือกแฟ้มที่ต้องการเปิดใช้งานที่มีนามสกุลเป็น .pdf 
• แดรกเม้าส์แฟ้ม PDF ที่ต้องการเปิดไปใส่ในหน้าต่าง Foxit Reader 

2.3.2 การทำงานกับ PDF 

• การย้ายไปยังส่วนต่าง ๆ ของเอกสาร 
- ใช้เม้าท์เลื่อน หรือล้อของเม้าส์ 
- กดปุ่มบนแป้นพิมพ์ 
- ใช้คำสั่ง View -> Go To หรือกดแป้น ctrl+G 
- ใช้ Bookmark ด้วยคำสั่ง View -> Navigation Panels -> Bookmarks 

• การหมุนเอกสาร 
- หมุนซ้ายทั้งเอกสาร ใช้คำสั่ง Home -> Rotate Left  
- หมุนซ้ายทั้งเอกสาร ใช้คำสั่ง Home -> Rotate Right 

 

• การย่อ/ขยายเอกสาร 
- กดรูป  เพ่ือย่อ 
- กดรูป  เพ่ือขยาย 

 

• การค้นหาข้อความในแฟ้ม 

- ค้นหาข้อความจาก Find Box  
• การเลือกข้อความ 

- เลือกคำสั่งบนแถบเครื่องมือเมนู Home -> Select  เพ่ือช่วยเลือกข้อความใน
เอกสารใน PDF เพ่ือคัดลอกไปใช้ในเอกสารอ่ืนได้มีข้ันตอนดังนี้ 
1) เลือกบรรทัดข้อความโดยย้าย cursor ไปวาง ณ บรรทัดที่ต้องการเลือก 
2) แดรกเมาส์เพ่ือเลือกข้อความ หรือ Double-click บนข้อความท่ีจะเลือก 
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3) หากต้องการเลือกหลาย ๆ ย่อหน้า ให้คลิกเมาส์ที่ตำแหน่งเริ่มต้นแล้วหมุนล้อของเมาส์
ลงไปจนถึงตำแหน่งสุดท้ายที่ต้องการจะเลือกจากนั้นกด Shift + คลิกเมาส์ 

4) หากต้องการเลือกข้อความทั้งหมดในเอกสารให้กดปุ่ม Ctrl + A 
5) หากต้องการยกเลิกการเลือก ให้คลิกบนเอกสารอีกครั้ง 

• การคัดลอกข้อความ 
- หลังจากเลือกข้อความแล้ว ให้คลิกขวาแล้วเลือกคำสั่ง Copy หรือกดปุ่ม Ctrl + C 

• การวางข้อความที่คัดลอก 
- คลิกเลือกตำแหน่งที่ต้องการวางข้อมูลในโปรแกรมอ่ืน ๆ เช่น Microsoft Word, Notepda 

เป็นต้น แล้วคลิกขวาเลือกคำสั่ง Paste 
• การคัดลอกรูปภาพ 

- เลือกคำสั่งบนแถบเครื่องมือเมนู Home -> SnapShot  เลือกตำแหน่งที่
ต้องการวางข้อมูลในโปรแกรมอ่ืน ๆ เช่น Microsoft Word, Notepda เป็นต้น แล้วคลิก
ขวาเลือกคำสั่ง Paste 

• การซ่อน/แสดงแถบไม้บรรทัด 

- เลือกคำสั่งบนแถบเครื่องมือเมนู View -> Rulers   

2.3.3 การใส่หมายเหตุ (Annotation) 

เครื่องมือที่ใช้สำหรับอธิบายประกอบไฟล์ PDF ได้แก่  

1. เครื่องมือพิมพ์ดีด (Typewriter) -> ไปที่แถบเครื่องมือ เมนู Comment -> Typewriter 

 
- เลือก Callout  
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- เลือก Textbox 

 
2. เครื่องมือวาดทำแถบมาร์กอัพ (Drawing Markup Tools) 

 
-    Rectangle ใช้สำหรับวาดรปูทรงสี่เหลี่ยมลงในเอกสาร PDF 
-    Oval ใช้สำหรับวาดรูปทรงวงรี วงกลมลงในเอกสาร PDF 
-     Polygon ใช้สำหรับวาดรปูทรงหลายเหลี่ยมลงในเอกสาร PDF 
-   Cloud ใช้สำหรับวาดรูปทรงก้อนเมฆลงในเอกสาร PDF 
-    Arrow ใช้สำหรับวาดเส้นที่มีหัวลูกศรลงในเอกสาร PDF 
-    Line ใช้สำหรับวาดเส้นลงในเอกสาร PDF 
-   Polyline ใช้สำหรับวาดเส้นหลายหยักลงในเอกสาร PDF 
-    Pencil ใช้สำหรับเขียนข้อความลงในเอกสาร PDF 

-     Eraser ใช้สำหรับลบสิ่งที่เขียนด้วย Pencil Tool ออกจากเอกสาร PDF 
 

3. เครื่องมือมาร์กอัพ ข้อความ (Text Markup) 

 
-  Highlight Text ทำแถบสีระบายข้อความ 
-  Squiggly Text วาดเส้นไก่เข่ียใต้ข้อความคล้ายกับขีดเส้นใต้ 
-  Underline Text ใส่เส้นใต้ให้กับข้อความ 
-   Strikeout Text ตีเส้นขีดกลางข้อความในบรรทัดนั้น ๆ  

-  Replace Text แทนที่ข้อความโดยขีดฆ่าข้อความเก่า 

-   Insert Text แทรกข้อความ 



หลักสตูร “การตัดต่อแกไ้ขไฟล์ PDF ด้วยโปรแกรม Open Source”                                                       22 

2.3.4 การสร้าง Bookmarks 

เลือกแถบเมนู View -> คำสั่ง Navigation Pannels -> Bookmarks ตรงที่ต้องการที่จะสร้างบุ๊ค
มาร์ค 

 
 

3. การใช้งาน PDF Fill 

3.1 PDF Fill คืออะไร 

เป็นโปรแกรมท่ีใช้ในการจัดการไฟล์ PDF ไม่ว่าจะเป็นการสร้างไฟล์ PDF, การแก้ไข PDF, การรวมไฟล์ 
PDF, การแยกไฟล์ PDF, การแปลงไฟล์ PDF, การเข้ารหัส ถอดรหัส PDF, การใส่ข้อมูลเข้าไปในไฟล์ เช่น 
หัวข้อไฟล์ PDF, รายละเอียดไฟล์ PDF, คำสำคัญของไฟล์ PDF, ผู้แต่ง เป็นต้น 

3.2 การติดตั้งและการเรียกใช้โปรแกรม 

• ดาวน์โหลดติดตั้ง PDFSam จากลิงค์ https://www.pdfill.com/download.html เลือก Get 
FREE Basic Version 

 
 

• ดับเบ้ิลคลิกไอคอน  
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• ดับเบ้ิลคลิกไอคอน 

 
 

• จะปรากฏหน้าต่างโปรแกรมดังรูป 
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3.3 Function การทำงาน 

3.3.1 Merge PDF Files  รวมแฟ้ม PDF 

 
- Add a PDF File, Add PDF Files under a Folder เพ่ิมไฟล์ PDF ที่ต้องการรวม 
- Move Up เลื่อนลำดับของไฟล์ที่เลือกข้ึนก่อน 
- Move Down เลื่อนลำดับของไฟล์ที่เลือกลง 
- Remove นำไฟล์ PDF ที่เลือกออก 
- Sort เรียงไฟล์ PDF ที่เลือกตามชื่อ 
- Save As บันทึกไฟล์ลงพ้ืนที่ที่ต้องการ พร้อมทั้งตั้งชื่อไฟล์ 

3.3.2 Split or Reorder Pages ตัดต่อเรียงลำดับหน้าให้กับแฟ้ม PDF 

 
- Split Pages From แยกไฟล์ PDF โดยระบุหน้า 
- Reorder Pages แยกไฟล์ PDF โดยการระบุเป็น เลขหน้า, ช่วงของหน้า, หน้าคู่, หน้าคี่, กลับ

หลังไปหน้า, หน้าสุดท้ายเท่านั้น 
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- Delete Pages เลือกหน้าที่ต้องการจะลบในไฟล์ PDF โดยการะบุเป็นเลขหน้า, ช่วงของหน้า, 
หน้าคู่, หน้าคี่, หน้าสุดท้าย 

- Keep Bookmarks เก็บบุ๊คมาร์คไว้ 
- Extract Pages As Separate Files แยกไฟล์ในแต่ละหน้าที่ระบุ 
- Open the Extracted PDF เปิดไฟล์หลังมีการแยกไฟล์ PDF เสร็จสิ้นแล้ว 
- Save the other pages as a PDF file บันทึกไฟล์ที่ไม่ได้ระบุให้แยกไฟล์ไว้ในอีกไฟล์ 

3.3.3 Encrypt and Decrypt Options ตั้งค่าคุณสมบัติการเข้ารหัสและถอดรหัส 

 
- User Password รหัสผ่านสำหรับผู้ใช้งานทั่วไป  
- Owner Password รหัสผ่านสำหรับเจ้าของไฟล์ PDF 
- Encryption Level  เข้ารหัสผ่านแบบ 40 บิต หรือ 128 บิต 
- Security Options เป็นการระบุสิทธิในไฟล์ PDF ของผู้ใช้งานทั่วไป  
- Encrypt As เข้ารหัส พร้อมตั้งชื่อไฟล์ และท่ีจัดเก็บไฟล์ 
- Decrypt As ถอดรหัส พร้อมตั้งชื่อไฟล์ และท่ีจัดเก็บไฟล์ 

3.3.4 Rotate of Crop PDF Pages หมุนและตัดหน้าเอกสาร PDF 
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- Select Page เลือกหน้าที่ต้องการหมุน โดยเลือก Landscape Page Only (หน้ากระดาษ
แนวนอนเท่านั้น) , Portrait Page Only (หน้ากระดาษแนวตั้งเท่านั้น) , All Pages (ทุกหน้า) 
, Even Page (หน้าคู่) , Odd Page (หน้าคี่) 

- Rotate by หมุนหน้ากระดาษ โดยเลือก 0 Degree (ไม่หมุน) , Clockwise 90 Degree 
(หมุนขวา 90 องศา) , 180 Degree (กลับหัว) , Counter Clockwise 90 (หมุนซ้าย 90 
องศา) 

- Crop Box ตัดหน้ากระดาษโดยเลือก Left Margin (ตัดขอบด้านซ้าย) , Right Margin ( ตัด
ขอบด้านขวา) , Top Margin (ตัดขอบด้านบน) , Bottom Margin (ตัดขอบด้านล่าง) 

3.3.5 Reformat Multiple Pages จัดรูปแบบหน้าเอกสาร PDF ใหม่อีกครั้ง 

 
- New PDF Page Size เปลี่ยนขนาดของ PDF โดยเลือก Portrait (แนวตั้ง) , Landscape 

(แนวนอน)  
- Original PDF Page Layout กำหนดโครงร่างของไฟล์ PDF โดยเลือก Rows (กำหนด

จำนวนแถว) , Columns (กำหนดคอลัมภน์) 
- Margin from Original PDF Page to New PDF Page Edge กำหนดขอบกระดาษ  
- Space between Original PDF Pages ช่องว่างระหว่างหน้าเมื่อมีการกำหนดแถวและ

คอลัมภน์ 
โดยเลือก Horizontal (แนวนอน) , Vertical (แนวตั้ง) 

- Show Note Lines แสดงช่องเพ่ือให้จดโน้ต 
- Show Original PDF Page’s Border แสดงกรอบของหน้า PDF เมื่อมีการกำหนดแถวและ

คอลัมภน์ 
- Line Color กำหนดสีของเส้นกรอบของหน้า PDF และกำหนด Line Width (ความกว้างของ

เส้น) 
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3.3..6 Add Header and Footer เพิ่มหัวและท้ายกระดาษ 

 
- Add Header (เพ่ิมหัวกระดาษ) , Add Footer (เพ่ิมท้ายกระดาษ) 
- Add on First Page เพ่ิมหัวกระดาษ/ท้ายกระดาษท่ีหน้าแรก 
- Show Page Number แสดงหัวกระดาษ/ท้ายกระดาษ 
- Text before Page Number ข้อความของหัวกระดาษ/ท้ายกระดาษก่อนเลขหน้า 
- Text after Page Number ข้อความของหัวกระดาษ/ท้ายกระดาษหลังเลขหน้า 
- Alignment ตำแหน่งของเลขหน้า 
- Page Offset ความห่างของตำแหน่งเลขหน้าจากขอบกระดาษท่ีตั้งไว้ 
- Text Properties เลือกคุณสมบัติของข้อความ โดยเลือก Font Encode (ชนิดของตัวอักษร

ตามประเทศ) , Font Name (ชื่อแบบตัวอักษร) , Font Size (ขนาดของตัวอักษร) , Font 
Style (สไตล์ของตัวอักษร) , Font Color (สีของตัวอักษร) 

- Margin from Edges เลือกความห่างของขอบกระดาษ 
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3.3.7 Add Watermark by text เพิ่มลายน้ำด้วยข้อความ 

 
- String ตัวอักษรที่ต้องการทำลายน้ำ 
- Font Encode ชนิดของตัวอักษรตามประเทศ 
- Font Name ชื่อแบบตัวอักษร 
- Font Style สไตล์ของตัวอักษร 
- Font Color สีของตัวอักษร 
- Stroke Color สีขอบตัวอักษร 
- Layout การวางของลายน้ำ โดยเลือก Horizontal (แนวนอน) , Vertical (แนวตั้ง) , 

Diagonal (แนวทแยง) 
- Draw Type การกำหนดการมองเห็นของลายน้ำ โดยเลือก Fill (เทสีตัวอักษร) , Fill and 

Stroke (เทสีขอบและตัวอักษร) , Invisible ( มองไม่เห็น) 
- Stroke Size ขนาดของขอบตัวอักษร 
- Order ลำดับการแสดงของลายน้ำ โดยเลือก Foreground (วางไว้หน้าตัวอักษร) , 

Background (วางไว้หลังตัวอักษร) 
- Save Options เลือกชื่อของลายน้ำ 
- Select String เลือกความหมายของลายน้ำ 
- Remove ลายน้ำ 
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3.3.8 Add Watermark by Image เพิ่มลายน้ำด้วยรูปภาพ 

 
- Scale Size ขนาดของรูปภาพที่จะนำมาทำลายน้ำ โดยเลือก Width (%ความกว้าง) Height 

(%ความสูง) , Rotate Degree (การหมุนภาพเป็นองศา)  
- Position ตำแหน่งของรูปภาพที่จะนำมาทำลายน้ำ โดยเลือก Center of the page 

(ก่ึงกลาง) , Any Position (ตำแหน่งอื่น ๆ โดยเลือกความห่างจากขอบหน้ากระดาษซ้ายและ
ขวา) 

- Order ลำดับการแสดงของลายน้ำ โดยเลือก Foreground (วางไว้หน้าตัวอักษร) , 
Background (วางไว้หลังตัวอักษร) 

- URL ลิงค์เมื่อคลิกเลือกลายน้ำนำไปสู่เว็บไซต์ 

3.3.9 Convert Images to PDF แปลงภาพให้เป็น PDF 
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- Add an Image / Add all Images under a Folder เพ่ิมรูปที่จะนำมาทำเป็นไฟล์ PDF 
- Move Up เลื่อนรูปที่เลือกขึ้น 
- Move Down เลื่อนรูปที่เลือกลง 
- Remove ลบรูปที่เลือก 
- Use Image Size to decide Page Size with DPI กำหนดความละเอียดของภาพที่นำมาทำ

เป็นไฟล์ PDF 
- New PDF Page Size เปลี่ยนขนาดของ PDF โดยเลือก Portrait (แนวตั้ง) , Landscape 

(แนวนอน)  
- Original PDF Page Layout กำหนดโครงร่างของไฟล์ PDF โดยเลือก Rows (กำหนด

จำนวนแถว) , Columns (กำหนดคอลัมภน์) 
- Margin from Original PDF Page to New PDF Page Edge กำหนดขอบกระดาษ  
- Space between Original PDF Pages ช่องว่างระหว่างหน้าเมื่อมีการกำหนดแถวและ

คอลัมภน์ 
โดยเลือก Horizontal (แนวนอน) , Vertical (แนวตั้ง) 

3.3.10 Convert PDF to Images แปลง PDF เป็นรูปภาพ 

 
- Select Page from เลือกหน้าของไฟล์ PDF ที่ต้องการทำเป็นไฟล์รูป 
- Image Resolution (6-600 dpi) ความละเอียดของรูป 
- Image Type ประเภทของไฟล์รูป ได้แก่ PNG, EPS, JPG, TIF, GIF, WMF, BMP, EMF 

 


